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DO NOT USE THIS PRODUCT IN LIFE SUPPORT SYSTEMS.

LIFE SUPPORT POLICY

ZILOG’S PRODUCTS ARE NOT AUTHORIZED FOR USE AS CRITICAL COMPONENTS IN LIFE 
SUPPORT DEVICES OR SYSTEMS WITHOUT THE EXPRESS PRIOR WRITTEN APPROVAL OF 
THE PRESIDENT AND GENERAL COUNSEL OF ZILOG CORPORATION. 

As used herein

Life support devices or systems are devices which (a) are intended for surgical implant into the body, or (b) 
support or sustain life and whose failure to perform when properly used in accordance with instructions for 
use provided in the labeling can be reasonably expected to result in a significant injury to the user. A criti-
cal component is any component in a life support device or system whose failure to perform can be reason-
ably expected to cause the failure of the life support device or system or to affect its safety or effectiveness.

Document Disclaimer

©2012 Zilog, Inc. All rights reserved. Information in this publication concerning the devices, applications, 
or technology described is intended to suggest possible uses and may be superseded. ZILOG, INC. DOES 
NOT ASSUME LIABILITY FOR OR PROVIDE A REPRESENTATION OF ACCURACY OF THE 
INFORMATION, DEVICES, OR TECHNOLOGY DESCRIBED IN THIS DOCUMENT. ZILOG ALSO 
DOES NOT ASSUME LIABILITY FOR INTELLECTUAL PROPERTY INFRINGEMENT RELATED 
IN ANY MANNER TO USE OF INFORMATION, DEVICES, OR TECHNOLOGY DESCRIBED 
HEREIN OR OTHERWISE. The information contained within this document has been verified according 
to the general principles of electrical and mechanical engineering. 

Z8051 is a trademark or registered trademark of Zilog, Inc. All other product or service names are the 
property of their respective owners. 

Warning:
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Revision History

Each instance in the Revision History table below reflects a change to this document from 
its previous version.

Date
Revision 
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Nov 
2012

07 Corrected pin values in Default Jumper Settings table. 6

Sep 
2012

06 Replaced incorrect screen in Figure 27. 31

Sep 
2012

05 Updates for Z8051 Installation Software release 2.0. 20, 26, 
33, 
45–46

Apr 
2012

04 Updated for improved usability. All

Mar 
2012

03 Added a G to end of part number to indicate RoHS compliance; added 
Figure 21.

25

Mar 
2012

02 Corrected filepaths in the Build and Run the Z51F3220 Demo Project section. 20

Feb 
2012

01 Original issue. All
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Introduction

This manual describes how to set up Zilog’s Z51F3220 Development Kit (Zilog part num-
ber Z51F3220000ZCOG) and use it to evaluate your Z8051-based designs and applica-
tions.

The Kit features a development board consisting of five LEDs, five pushbuttons, a buzzer, 
four 7-segment LCD digits, port pin headers and a UART-to-USB port. The Board fea-
tures the Z51F3220 MCU in a 44-pin MQFP package, plus a DBG connector to connect 
the Board to a host development PC using the Z8051 USB On-Chip Debugger (OCD) 
cable. For more details about the Z51F3220 MCU, please refer to the Z51F3220 Product 
Specification (PS0299). 

This document guides you through the following tasks:

• Install the Z8051 OCD Software and Documentation – see page 7

• Configure the Z8051 OCD and Z51F3220 Development Board – see page 17

• Build and Run the Z51F3220 Demo Project – see page 20

Figure 1 displays an image of the Z51F3220 Development Kit.

http://www.zilog.com/docs/ps0299.pdf
http://www.zilog.com/docs/ps0299.pdf
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Kit Contents

Table 1 lists the contents of the Z51F3220 Development Kit.

Figure 1. The Z51F3220 Development Kit

Table 1. Z51F3220000ZCOGG Contents

Item Description Quantity

1 Z51F3220 Development Board 1

2 Z8051 USB On-Chip Debugger (OCD) 1

3 Z8051 OCD Target Cable (10ckt) 1

4 USB Cable: A (male) to Mini-B 2

5 Z8051 OCD Software and Documentation CDROM 1

6 Z51F3220 Development Kit Insert (FL0139) 1
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Appendix 2 on page 3 displays an image of the Z51F3220 Development Board.

Supported Operating Systems

The Z51F3220 Development Board and the Z8051 On-Chip Debugger support the follow-
ing operating systems:

• Microsoft Windows XP

• Microsoft Windows Vista (32-bit/64-bit)

• Microsoft Windows 7 (32-bit/64-bit)

Z51F3220 Development Board Block Diagram

Figure 3 displays a block diagram of the Z51F3220 Development Board.

Figure 2. Z51F3220 Development Board



UM024307-1112  Introduction

Z51F3220 Development Kit
User Manual

4

Z51F3220 Development Board Description

The Z51F3220 Development Board consists of the following components:

• Z51F3220: U2, 44-pin MQFP chip

• 3 LEDs: Green (D2), Red (D3) and Yellow (D4) connected to the GPIO pins of the 
Z51F3220 MCU

• 1 green LED to indicate USB power: D5

• 1 red LED to indicate an overcurrent condition: D6

• 5 pushbuttons:

– SW1: RESET

– SW2–SW5: connected to the GPIO pins of the Z51F3220 MCU

• USB connector: P1

• OCD connector: J1

• USB-to-UART interface: U7

Figure 3. Block Diagram of the Z51F3220 Development Board 
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• USB interface providing power and communication to the Board through adjustable 
LD0: U5

• Power supply level that can be adjusted with potentiometer R22

• Overcurrent protection circuit on the Board: U6 and D6

• External source of reference voltage (2.5 V) for the on-chip ADC: VR1

• MCU current consumption measurement resistor R7 with test points J4 and J5

• Buzzer: U1

• 4-digit, 7-segment LCD panel

• Test points, headers and prototype area with two footprints

Figure 4. Z51F3220 Development Board: Highlighted Components

OCD Connector J1
R3 and R6 Voltage Divider

VR1 On-Chip ADC

Z51F3220 MCU
USB-to-UART IC

USB Power LED D5
Overcurrent LED D6
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By default, the Z51F3220 Development Board is set up with preinstalled shunts on J16 
jumper pins 1–2 and 3–4 to allow the interfacing of the Z51F3220 MCU’s UART0 to the 
USB port. When the Board is connected to the USB port of the host PC, LED D5 will be 
ON. The default settings and functionalities of these shunts are listed in Table 2.

As indicated in the table, should you decide to use the the Z51F3220 MCU’s UART1 
block as the interface for your own project (currently not supported in this release), move 
the J16 shunts to positions 5–6 and 7–8.

By default, Input 1 of the ADC is used to measure the supply voltage. This measurement 
point is taken from a middle point in the voltage divider circuit that includes resistors R3 
and R6; the scaling is performed by software so that the LCD always displays the actual 
voltage. For a visual representation, see the schematic diagram in Figure 32 on page 37.

If a short on the Board should occur, or if its attached component(s) require more than 
500 mA, the overcurrent protection functionality will trigger the red LED D6 to illuminate. 
In this instance, power to the Board will be terminated, and the USB port of the PC will be 
protected from shorting.

Schematic diagrams of the Z51F3220 Development Board are presented on pages 37 and 
38 of this document.

The physical dimensions of the Board are 4.01" x 2.50" (101.8 mm x 63.5 mm).

Table 2. Default Jumper Settings

Headers Pins Functionality Notes

J16 1–2, 3–4 UART0 to USB Default

J16 5–6, 7–8 UART1 to USB

J2 1–2 VCC is being measured by AN1 Default

J2 3–4 External VREF, 2.5 V is used for ADC Default



UM024307-1112  Install the Z8051 OCD Software and Documentation

Z51F3220 Development Kit
User Manual

7

Install the Z8051 OCD Software and 
Documentation

The Z8051 On-Chip Debugger (OCD) interface is the interface by which your PC will 
communicate with the Z51F3220 MCU to download and execute code. In addition to the 
OCD, software such as development tools and sample applications will be installed.

If you have already installed the Z8051 software and documentation from the CD-ROM 
following the procedure on the paper insert in your kit (FL0139), skip this section and pro-
ceed to the Z8051 OCD Driver Installation section, below.

Observe the following procedure to install the Z8051 On-Chip Debugger software and 
documentation on your computer.

1. Ensure that the OCD interface hardware is not connected to your PC.

2. Insert the Z8051 Software and Documentation CD into your computer’s CD-ROM 
drive. The setup program launches automatically. If the setup program does not launch 
automatically, open Windows Explorer, browse to your CD-ROM drive, and double-
click the file labeled Z8051_<version_number>.exe.

In this filename, <version_number> refers to the version number of the OCD Software 
and Documentation release. For example, this version number may be 1.0.

3. Follow the on-screen instructions to complete the OCD software installation.

Z8051 OCD Driver Installation

The driver programs for the Z8051 On-Chip Debugger are copied during the software and 
documentation installation. In the following procedure for PCs running the Windows 7 32- 
and 64-bit operating systems, ensure that the target side of the OCD will remain uncon-
nected while you install these drivers. 

If you are running Windows Vista, see Appendix A on page 39 to install your device driv-
ers. If you are running Windows XP, see Appendix B on page 42.

Note:

Note:

Note:
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1. Connect the OCD hardware to the USB port of your PC by connecting the A (male) 
end of one of the two USB A (male)-to-Mini-B cables with the host PC’s USB port. 
Connect the Mini-B end to the OCD device.

2. After the PC detects the new hardware, it will display the Installing device driver soft-
ware dialog shown in Figure 5.

3. Select Browse my computer for driver software (advanced) to display the dialog 
shown in Figure 6, which prompts you to key in or browse for the location of the .inf 
file. Depending on the type of computer you use (32- bit or 64-bit), use the Browse 
button to navigate to one of the following paths, then click the Next button.

– On 32-bit machines, use the following path: 

<Z8051 Installation>\Z8051_<version_number>\device drivers\OCD USB\x32

– On 64-bit machines, use the following path: 

<Z8051 Installation>\Z8051_<version_number>\device drivers\OCD USB\x64

Figure 5. Install Device Driver Dialog, Windows 7

IMPORTANT NOTE: If you should encounter the scenarios presented in Figures 9 or 10, right-click 
your mouse on ZILOG OCD I/F (highlighted in Figure 9) or Unknown device (highlighted in Figure 10) 
and select Update Driver Software... 
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Figure 6. Browse For Driver Dialog, Windows Vista
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4. When Windows prompts you whether to install or not install, as shown in Figure 7, 
click Install this driver software anyway and wait until the installation is completed 
(Windows may prompt you more than once). 

Figure 7. Can’t Verify Publisher Dialog, Windows Vista
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5. When the installation is complete, the screen shown in Figure 8 will appear. Click 
Close to exit the OCD driver installation.

On some installations, the Found New Hardware screen shown in Figure 8 may also dis-
play the text string, Zilog Z8051 USB OCD - No Firmware. This occurrence is normal 
and can be disregarded.

Figure 8. Successfully Installed Dialog, Windows Vista

Note:
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Figure 9. Unsuccessful Installation, Scenario 1
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Figure 10. Unsuccessful Installation, Scenario 2
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6. If Zilog Z8051 USB OCD appears in the Device Manager (as highlighted in 
Figure 11), the OCD driver software has been successfully installed.

Figure 11. Device Manager Dialog, Windows 7
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FTDI USB-to-UART Driver Installation

An FTDI USB-to-UART driver is required to allow your PC to communicate through its 
USB port to the on-chip UART of the Z51F3220 MCU. Observe the following procedure to 
perform these connections.

1. Ensure that the USB cable is not plugged in to the Z51F3220 Development Board’s P1 
connector.

2. Navigate to the following filepath and double-click the CDM20802_setup.exe file to 
begin the driver installation.

<Z8051 Installation>\Z8051_<version_number>\device drivers\FTDI Uart

3. The installation process will begin and you should observe output similar to the fol-
lowing messages on the screen of your PC:

32-bit OS detected
<installation path>\dpinstx86.exe
Installation driver
FTDI CDM driver installation process completed.

The above message may appear for a short time, but will then disappear from your window. 
This occurrence is normal.

4. When the installation is complete, plug in the Mini-B connector of the second USB 
cable into the Board, and the larger A connector into the USB port of your PC. Refer 
to Figure 15 on page 19 for guidance.

5. If the driver installation was successful, the Ports (COM & LPT) section of the Device 
Manager will display USB Serial Port (COMx) or similar message, as highlighted in 
Figure 12.

Note:
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To launch the Device Manager on Windows 7 systems, launch the Start menu, enter device 
manager in the Search programs and files field, and press the Enter key.

To open the Device manager on earlier Windows systems, navigate via the following path:

Start → Control Panel → System → Hardware → Device Manager → Ports (COM& LPT)

Figure 12. A Successful USB-to-UART Driver Installation

Note:



UM024307-1112  Configure the Z8051 OCD and Z51F3220 Development 

Z51F3220 Development Kit
User Manual

17

Configure the Z8051 OCD and Z51F3220 
Development Board

Observe the following procedure to set up and configure the Z8051 On-Chip Debugger 
and the Z51F3220 Board.

Steps number 1 to 4 present the power-up sequence. Carefully follow these steps to avoid 
encountering an improper connection or disconnection.

1. Connect the Z8051 On-Chip Debugger (OCD) to the host PC’s USB port.

2. Connect one end of the 10-circuit cable to the Z8051 OCD.

3. Connect the other end of the 10-circuit cable connector to the Z51F3220 Board’s J1 
connector. Pin 1 of the cable connector is indicated by a red stripe, as shown in 
Figure 13.

Figure 13. Connecting the 10-Circuit Cable to the Board

Caution:
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4. Using the second USB-to-Mini-B cable, connect the standard USB end to the host 
PC’s USB port.

5. Connect the other end of this second Mini-B cable to the Z51F3220 Board’s P1 con-
nector to apply power to the Board. Note that the green LED D5 is ON; see Figure 14.

In the event that you later remove the LCD panel from the Board, observe its orientation in 
Figure 14. The panel’s small plastic notch should be located in the position indicated by the 
red square.

Figure 15 shows an example of a completed hardware and software setup.

Figure 14. Connecting the USB Mini-B Cable to the Board

Note:
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Figure 15. An Example Setup
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Build and Run the Z51F3220 Demo 
Project

Observe the following procedure to build and run the Z51F3220 demo project.

If you plan to use the Keil µVision IDE, please skip to the the Using the Keil µVision IDE 
on a Demo Project section on page 26.

1. Browse to the following location and double-click the build_sdcc.bat batch file to 
build the project:

<Z8051 Installation>\Z8051_<version_number>\samples\Z51F3220\Demo\build_sdcc.bat

Refer to the Z8051 Tools Product User Guide (PUG0033) for additional information about 
these project files and Small Device C Compiler (SDCC) development tools.

2. When the build is complete, the command window will prompt the user to press any 
key to continue. Proceed by pressing any key on your keyboard; as a result, a hex file 
for the demo will be created in the following path:

<Z8051 Installation>\Z8051_<version_number>\samples\Z51F3220\Demo\demo.hex

3. Set up the OCD and Development Board. If you have not already configured these 
items, please return to the Configure the Z8051 OCD and Z51F3220 Development 
Board section on page 17.

4. Run the Z8051 OCD software. From the Start menu, navigate to All Programs → 
Zilog Z8051 Software and Documentation <version_number> → Zilog Z8051 
OCD <version_number>. Once launched, the program will display Connected, as 
shown in Figure 16.

If you encounter a message that says Disconnected, return to the Configure the Z8051 
OCD and Z51F3220 Development Board section on page 17 to configure the proper 
power-up sequence. If the problem persists, Zilog recommends that you review the Z8051 
OCD Driver Installation and FTDI USB-to-UART Driver Installation sections.

Note:

Note:

Note:
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For a free download of the latest version of the OCD software, visit the Zilog website and 
navigate via the Tools and Software menu to Software Downloads.

5. In the Debugger window, select Load Hex from the File menu to display the Object 
File dialog, which is shown in Figure 17.

Figure 16. Initial OCD Screen

Note:

http://www.zilog.com/
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6. In the Object File dialog, browse to the hex file that you created in Step 2 and click 
Open.

7. Click the Download button to open the Configuration dialog box, shown in Figure 18.

Figure 17. Object File Dialog
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8. Select Enable/Reset input and click the Write button to open the Configuration Is 
Changed dialog. A typical OCD display, if child windows are open, is shown in 
Figure 19.

Please disregard the instructions stated in the Configuration Is Changed dialog, and pro-
ceed to Step 9.

Figure 18. Configuration Dialog

Note:
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9. Click OK to open the On-Chip Debugger’s main window. A typical OCD display is 
shown in Figure 20; Figure 21 shows an OCD window with child windows open.

Figure 19. Configuration Is Changed Dialog

Figure 20. A Typical On-Chip Debugger Window
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Use the View menu to open the child windows. For this demonstration, the example win-
dows shown in Figure 21 do not need to be opened.

10. Click the Reset & Go toolbar icon, shown in Figure 22. As a result, LEDs D2, D3 and 
D4 on the Z51F3220 Board will blink in sequence and the LCD panel will display the 
current voltage applied to the Board.

Figure 21. A Typical On-Chip Debugger Window with Child Windows Open

Figure 22. Reset & Go Toolbar Icon

Note:
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Similar projects that you can use as references are listed in Table 3 on page 36.

Using the Keil µVision IDE on a Demo Project

Zilog’s On-Chip Debugger hardware now fully supports the Keil µVision IDE. Our target 
driver is seamlessly integrated with the Keil debugger, allowing Keil C51 users to work 
within the µVision4 environment without switching between the Keil compiler and 
Zilog’s external OCD software. In the demo project example that follows, the Z51F3220 
MCU-related project is referenced as Demo. 

This document refers to the Keil µVision IDE V4.53.0.6 (PK51 Prof. Developers Kit) or 
later.

Refer to the Z8051 Tools Product User Guide (PUG0033) for additional information about 
these project files and debugging with the Keil µVision IDE and Zilog On-Chip Debugger.

Debugger Configuration

Observe the following procedure to build and run a Z51F3220 demonstration project using 
the Keil µVision IDE.

1. Start the Keil µVsion4 IDE.

2. From the Project menu, select Open Project and navigate to the following filepath:

<Installation directory>\Z8051_<version>\samples\Z51F3220\Demo

3. Select the Demo.uvproj file and click Open; see Figure 23.

Note:

Notes:

http://www.zilog.com/docs/devtools/pug0033.pdf
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4. Return to the Project menu and select Options for Target ‘Demo’.

5. In the Options for Target ‘Demo’ dialog that appears, click the Device tab and ensure 
that your target is properly selected for your project, as illustrated in Figure 24.

Figure 23. Selecting the Demo Project File
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6. After selecting the target, click the Debug tab and select the Zilog Z8051 Target 
Driver from the Use: drop-down menu, as highlighted in Figure 25.

Figure 24. Selecting the Target
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7. Click the Settings button, located to the right of this drop-down menu, to configure 
your Debug and Flash options. The Settings dialog is displayed with the Debug 
Options tab appearing by default, as shown in Figure 26.

Figure 25. Selecting the Target Driver
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When configuring the appropriate Debug option, be aware of the following stipulations:

• Checking the Peripheral continues running option means that the timers used in 
your project will run while the processor is stopped by the debugger.

• The Reset at Main option will only work if you have a main file in your project; oth-
erwise you should deselect this option.

8. Click the Flash Options tab. The Flash Options Settings dialog will appear, as shown 
in Figure 27. To select the proper options for Flash programming, refer to the 
Z51F3220 Product Specification (PS0299).

Figure 26. Configuring the Debug Options

Notes:

http://www.zilog.com/docs/ps0299.pdf
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9. Click OK to exit the Settings dialog.

10. From the Options for Target ‘Demo’ dialog, select the Load Application at Startup 
checkbox, as shown in Figure 28, the so that the IDE will download the code upon 
connection. There is no need to select or enter an initialization file.

11. Click OK to exit the Options for Target ‘Demo’ dialog.

12. From the Project menu, select Rebuild All to rebuild all target files.

Figure 27. Configuring the Flash Options

Figure 28. Load Application at Startup Settings



UM024307-1112  Build and Run the Z51F3220 Demo Project

Z51F3220 Development Kit
User Manual

32

13. Start your debugging session by clicking the Start/Stop Debug Session icon, as indi-
cated in Figure 29. A default Windows configuration of the debug session is shown in 
Figure 30.

Figure 29. Beginning a Debug Session

Figure 30. A Default Debug Session
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The following buttons in the Keil µVision IDE are not supported by the Zilog OCD driver:

To learn more about the full functionality of the Keil µVision IDE, please refer to the Keil 
Keil µVision4 IDE documentation.

14. From the Debug menu, select Run, or simply press the F5 key on your Windows key-
board to run the demo project. As a result, LEDs D1, D2 and D3 on the Z51F3220 
Evaluation Board will blink in sequence.

15. To stop code execution, select Stop from the Debug menu.

16. To stop your debugging session, click the Start/Stop Debug Session icon.

Refer to Appendix C on page 45 for a discussion of Stand-Alone Flash Programming 
Using the Keil µVision IDE.

HyperTerminal Configuration

A communications program such as HyperTerminal can be used on Windows XP systems 
to view the messages from the Z51F3220 Development Board. The following procedure 
examines how to configure HyperTerminal for the Z51F3220 demo project.

The HyperTerminal application is not available in Windows Vista and Windows 7 systems. 
If you are using either of these operating systems, consider using/installing different com-
munication software, such as Tera Term. Please refer to the documentation for the particu-
lar emulation software you use to configure it for communication with the Z51F3220 
Development Board.

1. In HyperTerminal, select the COM port assigned to the USB-to-UART interface cable 
that is connected to the P1 connector on the Development Board.

Note:

Note:

Note:
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This COM port can be determined from the Device Manager, as described in the the FTDI 
USB-to-UART Driver Installation section on page 15.

2. Configure this port to reflect the following settings: 

– 9600 bps

– 8 data bits

– No parity

– 1 stop bit

– No flow control

3. Click the Call button to connect to the Z51F3220 Board. Upon connection, you should 
be able to see the Demo program menu shown in Figure 31.

Figure 31. Demo Program Menu in HyperTerminal

Note:
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At this point, you have successfully run the Z51F3220 demo project, but you are welcome 
to continue evaluating the demo in HyperTerminal. For additional information about how 
to create, edit, run and debug this project, please see the Z8051 Tools Product User Guide 
(PUG0033) and/or the Z8051 On-Chip Debugger and In-System Programmer User Man-
ual (UM0240).

Turn off the power by removing the USB cable from the P1 connector on the Development 
Board.

Note:

http://www.zilog.com/docs/devtools/pug0033.pdf
http://www.zilog.com/docs/devtools/pug0033.pdf
http://www.zilog.com/docs/devtools/UM02400103.pdf
http://www.zilog.com/docs/devtools/UM02400103.pdf
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Sample Projects and Documentation

A number of sample projects are included on the CD that ships with the Z51F3220 Devel-
opment Kit, and their locations, listed in Table 3, will be accessible upon installation.

A number of Z8051-related documents are included in the Z51F3220 Development Kit, 
and their locations, listed in Table 4, will be accessible upon installation. You can also find 
current versions of each of these documents on the Zilog website.

Table 3. Z51F3220 Development Kit Sample Projects 

Description Location

Demo samples\Z51F3220\Demo 

Led Blink samples\Z51F3220\Led_Blink 

samples\Z51F3220\Led_Blink_Asm

Table 4. Z51F3220 Development Kit Documentation 

Description Document Location

Z51F0410 Product Specification PS0295 Documentation\Chip_Documentation

Z51F0811 Product Specification PS0296 Documentation\Chip_Documentation

Z51F3220 Product Specification PS0299 Documentation\Chip_Documentation

Z51F3221 Product Specification PS0300 Documentation\Chip_Documentation

Z51F6412 Product Specification PS0303 Documentation\Chip_Documentation

Z51F0410 Product Brief PB0237 Documentation\Chip_Documentation

Z51F3220 Product Brief PB0238 Documentation\Chip_Documentation

Z51F3220 Product Brief PB0239 Documentation\Chip_Documentation

Z51F3221 Product Brief PB0240 Documentation\Chip_Documentation

Z51F6412 Product Brief PB0241 Documentation\Chip_Documentation

Z8051 OCD and ISP User Manual UM0240 Documentation\Tools_Documentation

Z51F0811 Evaluation Kit User Manual UM0242 Documentation\Tools_Documentation

Z51F3220 Development Kit User Manual UM0243 Documentation\Tools_Documentation

Z8051 Tools Product User Guide PUG0033 Documentation\Tools_Documentation

http://www.zilog.com/
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Schematic Diagrams

Figures 32 and 33 display schematic diagrams of the Z51F3220 Development Board.

Figure 32. Z51F3220 Development Board, #1 of 2
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Figure 33. Z51F3220 Development Board, #2 of 2

PWR_EN-

SERIAL USB
1-2, 3-4 UART0
5-6, 7-8 UART 1

VCC_T

RxD1
TxD1

RxD0
TxD0

VCC_T

VCC_5V

VCC_5V

VCC_T

RxD0
TxD0
RxD1
TxD1

R19
20K
R19
20K

J15J15

1

R18

470

R18

470

U7

FT232RL

U7

FT232RL

USBDM
16 RTS

3
G

N
D

1
7

RI
6

NC1
8

DTR
2

VCCIO
4

3v3 OUT
17

NC
24

RESET
19

TXD
1

USBDP
15

CBUS3
14

OSCI
27

OSCO
28

G
N

D
2

18

T
E

S
T

26

CBUS1
22

G
N

D
3

21

DCD
10

CTS
11

DSR
9

RXD
5

CBUS4
12

CBUS2
13

A
G

N
D

25

CBUS0
23

VCC
20

C14

0.1uF

C14

0.1uF

U5

MIC5318

U5

MIC5318

GND
2

EN
1

IN
3

ADJ
5

OUT
4

BYP
6

Center Pad
7

R20
1.5K
R20
1.5K

J13J13

1

R23
4.75K 
R23
4.75K 

R21
20K
R21
20K

C13

0.01uF

C13

0.01uF

J14J14

1

L1
FERRITE BEAD
L1
FERRITE BEAD

C12

0.01uF

C12

0.01uF

J11J11

1

C10

4.7uF

C10

4.7uF

R25
4.7K 
R25
4.7K 

J16

HDR/PIN 2x4

J16

HDR/PIN 2x4

1 2
3 4
5 6
7 8

U6

TPS2051B

U6

TPS2051B

OUT
1

GND
2

OC
3

EN
4

IN
5

P1

USB, mini B

P1

USB, mini B

VBUS
1

DM
2

DP
3

ID
4

GND
5

SH1
6

SH2
7

SH3
8

SH4
9

h1
10

h2
11

D6

RED

D6

RED

2 1

C9

1uF

C9

1uF

J12J12

1

C6

4.7uF

C6

4.7uF

C11

0.1uF

C11

0.1uF

R24

470

R24

470

R22
20K
R22
20K

1
3

2

J10J10

1

R26

100K

R26

100K

D5

GREEN

D5

GREEN

21

C8

1uF

C8

1uF

C7

0.1uF

C7

0.1uF



UM024307-1112  OCD Driver Installation on Windows Vista Systems

Z51F3220 Development Kit
User Manual

39

Appendix A. OCD Driver Installation on 
Windows Vista Systems

The driver programs for the Z8051 On-Chip Debugger are copied to the development PC 
during the software and documentation installation. In the following procedure for PCs 
running Windows Vista 32- and 64-bit operating systems, ensure that the target side of the 
OCD will remain unconnected while you install these drivers. 

1. Connect the OCD hardware to the USB port of your PC by connecting the A (male) 
end of one of the two USB A (male)-to-Mini-B cables with the development PC’s 
USB port. Connect the Mini-B end to the OCD device.

2. After the PC detects the new hardware, it will display the Found New Hardware Wiz-
ard dialog box, shown in Figure 34. Click Locate and install driver software (rec-
ommended). 

3. Depending on your development PC’s User Account Control settings, Windows may 
ask for permission to continue the installation. Click Continue.

Figure 34. Found New Hardware Dialog, Windows Vista



UM024307-1112  OCD Driver Installation on Windows Vista Systems

Z51F3220 Development Kit
User Manual

40

4. When the Insert the Disc dialog appears, as shown in Figure 35, select I don’t have 
the disc. Show me other options. Click the Next button to display the dialog that 
follows, which is shown in Figure 36.

Figure 35. Install Device Driver Dialog, Windows Vista
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5. Return to page 8 and follow Steps 3 through 6.

Figure 36. Couldn’t Find Driver Dialog, Windows Vista
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Appendix B. OCD Driver Installation on 
Windows XP Systems

The driver programs for the Z8051 On-Chip Debugger are copied during the software and 
documentation installation. In the following procedure for Windows XP systems, ensure 
that the target side of the OCD will remain unconnected while you install these drivers.

1. Connect the OCD hardware to the USB port of your PC by connecting the A-Male end 
of one of the two USB A (male)-to-Mini-B cables with the host PC’s USB port, and 
connect the Mini-B end to the OCD device.

2. After the PC detects the new hardware, it will display the Found New Hardware Wiz-
ard dialog box, shown in Figure 37. Select Install from a list or specific location 
(Advanced); then click Next. 

Figure 37. The Found New Hardware Wizard Welcome Screen
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3. The next dialog box, shown in Figure 38, prompts you to enter a path or navigate to 
the directory in which the .inf file was installed. Depending on the type of computer 
you use (32- bit or 64-bit), use the Browse button to navigate to one of the following 
paths and click the Next button, leaving all other selections at their default settings.

– On 32-bit machines, use the following path:

<Z8051 Installation>\Z8051_<version_number>\device drivers\OCD USB\x32

– On 64-bit machines, use the following path:

<Z8051 Installation>\Z8051_<version_number>\device drivers\OCD USB\x64

On some installations, the Found New Hardware screen shown in Figure 37 may also dis-
play the text string, Zilog Z8051 USB OCD - No Firmware. This occurrence is normal 
and can be disregarded.

Figure 38. The Found New Hardware Wizard’s Browse Screen

Note:
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4. When Windows prompts you whether to continue the installation or stop, click the 
Continue Anyway button and wait until the installation is completed (Windows may 
prompt you more than once). When the installation is complete, click Finish.
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Appendix C. Stand-Alone Flash 
Programming Using the Keil µVision IDE

Observe the following procedure to program Flash memory without debugging.

1. From the Project menu, open the Options for Target 'your project’, and click the 
Utilities tab. In the Use Target Driver for Flash Programming drop-down menu 
within the Configure Flash Menu Command pane, ensure that Zilog Z8051 Target 
Driver is selected, as indicated in Figure 39.

2. Click the Settings button to change any additional Flash options. The Settings dialog 
will appear, as shown in Figure 40.

Figure 39. Selecting A Target Driver For Flash Programming
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3. After you have selected your Flash options, click OK to exit the Flash Options dia-
log.

4. Click OK to exit the Options For Target ‘Demo’ dialog.

5. From the Flash menu of the Keil IDE (see Figure 41), select either of the following 
options:

– Select Download to program Flash memory with the current project

– Select Erase to perform a mass erase of internal Flash memory

Figure 40. Configuring Additional Flash Options

Figure 41. The Keil IDE Flash Menu
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Customer Support

To share comments, get your technical questions answered, or report issues you may be 
experiencing with our products, please visit Zilog’s Technical Support page at http://sup-
port.zilog.com.

To learn more about this product, find additional documentation, or to discover other fac-
ets about Zilog product offerings, please visit the Zilog Knowledge Base or consider par-
ticipating in the Zilog Forum.

This publication is subject to replacement by a later edition. To determine whether a later 
edition exists, please visit the Zilog website at http://www.zilog.com.

http://support.zilog.com
http://support.zilog.com
http://www.zilog.com/kb
http://www.zilog.com/forum
http://www.zilog.com


Океан Электроники
Поставка электронных компонентов 

Компания «Океан Электроники» предлагает заключение долгосрочных отношений при 

поставках импортных электронных компонентов на взаимовыгодных условиях! 

Компания «Океан Электроники» является официальным дистрибьютором и эксклюзивным 
представителем в России одного из крупнейших производителей разъемов военного и 
аэрокосмического назначения «JONHON», а так же официальным дистрибьютором и 
эксклюзивным представителем в России производителя высокотехнологичных и надежных 
решений для передачи СВЧ сигналов «FORSTAR». 

Наши преимущества: 

- Поставка оригинальных импортных электронных компонентов напрямую с производств Америки, 
Европы и Азии, а так же с крупнейших складов мира; 
- Широкая линейка поставок активных и пассивных импортных электронных компонентов (более 
30 млн. наименований); 
- Поставка сложных, дефицитных, либо снятых с производства позиций; 
- Оперативные сроки поставки под заказ (от 5 рабочих дней); 
- Экспресс доставка в любую точку России; 
- Помощь Конструкторского Отдела и консультации квалифицированных инженеров; 
- Техническая поддержка проекта, помощь в подборе аналогов, поставка прототипов;  
- Поставка электронных компонентов под контролем ВП; 
- Система менеджмента качества сертифицирована по Международному стандарту ISO 9001; 
- При необходимости вся продукция военного и аэрокосмического назначения проходит 
испытания и сертификацию в лаборатории (по согласованию с заказчиком);
- Поставка специализированных компонентов военного и аэрокосмического уровня качества 
(Xilinx, Altera, Analog Devices, Intersil, Interpoint, Microsemi, Actel, Aeroflex, Peregrine, VPT, Syfer, 
Eurofarad, Texas Instruments, MS Kennedy, Miteq, Cobham, E2V, MA-COM, Hittite, Mini-Circuits, 
General Dynamics  и др.); 

«JONHON» (основан в 1970 г.)

Разъемы специального, военного и аэрокосмического 
назначения: 
(Применяются в военной, авиационной, аэрокосмической, 
морской, железнодорожной, горно- и нефтедобывающей 
отраслях промышленности) 

«FORSTAR» (основан в 1998 г.) 

ВЧ соединители, коаксиальные кабели, 
кабельные сборки и микроволновые компоненты: 

(Применяются в телекоммуникациях гражданского и 
специального назначения, в средствах связи, РЛС, а так же 
военной, авиационной и аэрокосмической отраслях 
промышленности). 

Телефон:    8 (812) 309-75-97 (многоканальный) 
Факс:           8 (812) 320-03-32 
Электронная почта:    ocean@oceanchips.ru 
Web:      http://oceanchips.ru/ 
Адрес:   198099, г. Санкт-Петербург, ул. Калинина, д. 2, корп. 4, лит. А


